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W-2c por Internet 
 
 

    Contiene las siguientes lecciones: 
 
 

• Lección 1: Crear/Reanudar formularios W-2c por Internet 

• Lección 2: Descargar informes ya presentados 

• Apéndice: Otras páginas 
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LECCIÓN 1: CREAR/REANUDAR FORMULARIOS «W-2C ONLINE» 

Siga las siguientes instrucciones para crear hasta cincuenta informes con cincuenta formularios «W-2c 
Online» en cada registro.  

PASO 1: Dirija su navegador a la página del «Business Services Online (BSO, siglas en inglés) titulada 
«Welcome to Business Services Online» (Bienvenido a los Servicios por Internet para Empresas): 
www.segurosocial.gov/bso/bsowelcome.htm (solo disponible en inglés). 

 
PASO 2: Seleccione el botón que dice «Log In» (Ingrese) en la página titulada, «Business Services 

Online Welcome». El sistema mostrará la página titulada, «Log In to Online Services» (Ingrese 
a los Servicios por Internet).  

 

 

http://www.segurosocial.gov/bso/bsowelcome.htm
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PASO 3: Ingrese su «User ID» (Identificación de Usuario) y «Password» su contraseña. 

PASO 4: Seleccione el encasillado que dice, «I have read & agree to these terms» (He leído y estoy de 
acuerdo con estas condiciones) en la página titulada, «Log In to Online Services». 

Seleccione el botón de «Log In» para ver la página titulada, «BSO Main Menu ». 

Para regresar a la página inicial del BSO titulada «Welcome to Business Services Online», 
seleccione el enlace que dice «BSO Welcome» que está en la parte de arriba o de abajo  
de la página.   
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PASO 5: Seleccione el enlace que dice, «Report Wages to Social Security» (Informe los Salarios al 
Seguro Social) en la página del «BSO Main Menu». El sistema mostrará la página titulada, 
«Wage Reporting Attestation» (Confirmación de la Presentación de Salarios). 

 

PASO 6: Seleccione el botón que dice «I Accept» (Acepto) en la página titulada, «Wage 
Reporting Attestation» para ir a la página inicial del EWR (EWR home). 
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 Para regresar a la página del «BSO Main Menu», seleccione el botón de «I DO NOT 
Accept» (No Acepto). 

 

 
PASO 7: En la página inicial del EWR: 

Seleccione la ficha titulada, «W-2c/W-3c Online» (Formularios W-2c/W-3c por Internet). 
Luego, seleccione el enlace que dice, «Create/Resume Forms W-2c/W-3c Online» 
(Crear/Reanudar un formulario W-2c/W-3c por Internet).  Si no se encuentran informes que no 
hayan sido presentados, el sistema mostrará la página que dice «Before You Create Your 
Form(s) W-2c/W-3c» (Antes que comience a llenar sus formularios W-2c/W-3c). Si hay 
formularios W-2c/W-3c que no han sido presentados, el sistema mostrará la página titulada      
«Unsubmitted Reports».   

Puede tener un máximo de cincuenta registros de salarios que no hayan presentado. Cuando haya 
alcanzado el máximo de cincuenta registros «guardados», se le requerirá que primero presente por lo 
menos uno de los registros que no haya presentado antes de que se le permita comenzar un registro 
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nuevo. Si tiene cuarenta y nueve registros, o menos, puede continuar sin presentar los registros que ya 
existen. 

 

 
PASO 8: En la página titulada «Unsubmitted Reports»: 

Seleccione el botón que dice «Start a New Report Correction» (Comience un Informe de 
Corrección Nuevo). El sistema mostrará la página titulada, «Before You Create Your Form(s) 
W-2c/W-3c» (Antes de Crear Su Informe W-2c/W-3c).  

Seleccione el enlace que dice «Edit» (Editar) o el enlace del «Employer Name» (Nombre del 
Empleador) para ir a la página titulada «W-2c List for this Submission» (Lista de W-2c para  
esta Presentación). 

Seleccione el enlace que dice «Delete» para borrar un informe que no ha sido presentado. 
Luego aparecerá la página que dice «Are you sure you want to delete the unsubmitted 
report?» (¿Está seguro que quiere borrar el informe que no ha sido presentado?).  

Seleccione el botón que dice «Cancel» (Cancelar) para regresar a la página principal del 
«EWR» (EWR home). 

No puede presentar informes marcados en rojo después del 15 de abril del 2013 debido  
al estatus de limitación para correcciones de informes. No obstante, puede verlos  
y actualizarlos. 
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PASO 9: En la página titulada «Before You Create Your Form(s) W-2c/W-3c »: 
  

Provea la información correcta correspondiente al año tributable y el nombre de su empresa. Si 
ninguna de las situaciones nombradas en la sección que dice «Check for Exception» (Verifique 
si existe alguna excepción) aplica, seleccione el botón de «Continue» para ir a la página 
titulada, «Employer Information for this Wage Report Correction» (Información del Empleador 
para este Informe de Corrección de Salarios).  

Si aplica alguna de las situaciones descritas en la sección de «Check for Exception», seleccione 
el encasillado y el botón de «Continue» para ir a la página titulada «W-2c Online Restrictions» 
(Restricciones al Programa de W-2c por Internet).  

Seleccione el botón de «Cancel», para regresar a la página inicial del «EWR» (EWR home).  

 



Guía del BSO – Año Tributable 2012                                                                                                  W-2c por Internet 

   
Administración del Seguro Social  Página 7 
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PASO 10: En la página titulada «Employer Information for this Wage Report»: 

Ingrese o revise la información del empleador «Employer Information», información de la 
persona de contacto «Contact Person», cualquier otra información «Other Information»  y 
seleccione el tipo de pagador «Kind of Payer»  y el tipo de empleador «Kind of Employer», 
luego seleccione el botón de «Continue» para ir a la página titulada, «Enter W-2c Information» 
(Ingrese la información para el formulario W-2c).  

Seleccione el botón de «Cancel» para regresar a la página inicial del EWR home. 
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PASO 11: En la página titulada «Enter W-2c Information»: 

Seleccione el botón que dice «Save and Start NextW-2c», para guardar la información del 
formulario W-2c presente y comenzar otro. Es posible que el sistema muestre algunos sobre 
avisos. Si el sistema muestra un sobre aviso, puede proceder ya sea haciendo las correcciones 
al formulario W-2c o seleccionando el encasillado que invalida el sobre aviso. 

Cuando termine de completar los formularios W-2C, seleccione el botón de «Save and Go  
to W-2c List» (Guardar los formularios y vaya a la lista de los W-2c) para continuar a  
la página titulada «W-2c List for this Submission» (Lista de los formularios W-2c para  
esta Presentación). 

Puede ingresar hasta un máximo de cinco (25) formularios W-2cs. El número de los W-2c 
actuales se muestra en la parte superior de la página titulada, «Enter W-2c Information». 
Cuando haya ingresado el quinto formulario, el sistema ya no mostrará el botón de «Save and 
Start Next W-2c». 

Seleccione el botón de «Cancel Changes» (Cancelar los cambios) para rechazar los cambios 
efectuados a este W-2c y vaya a la página titulada, «W-2c List for this Submission». 

Seleccione el botón de «Delete this W-2c» (Borrar este W-2c): Si el formulario ha sido 
guardado previamente, el sistema mostrará la página titulada «Are you sure you want to delete 
this W-2c» (¿Está seguro que quiere borrar este W-2c?). Si el formulario no ha sido guardado 
previamente, el sistema mostrará la página titulada «W-2c List for Submission». 

 
PASO 12: En la página titulada «W-2c List for this Submission»:  

Seleccione un nombre para ver y corregir la información del W-2c.  

Seleccione el enlace que dice «Delete» para borrar el W-2c. Cuando seleccione este enlace, la 
página titulada «Are you sure you want to delete this W-2c» aparecerá para asistirlo. 

Seleccione el botón de «Save and Quit» para salir del formulario W-2c electrónico sin 
presentar su registro de salario al Seguro Social. Cuando seleccione este botón, la página  
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titulada «Are you sure you want to save and exit W-2c Online without submitting your annual 
wage report to SSA?» (¿Está seguro que quiere guardar los formularios W-2c por Internet y 
salir sin presentar los informes anuales de salarios al Seguro Social?) aparecerá para ayudarlo. 

Seleccione el botón de «Edit Employer Information» (Editar la Información Empresarial) 
para continuar a la página titulada, «Employer Information for this Wage Report Correction» 
(Información empresarial para esta corrección del informe de salarios). 

Seleccione el botón de «Start a New W-2c» (Comenzar un nuevo W-2c) para continuar a la 
página titulada, «Enter W-2c Information».  

 
Seleccione el botón de «Continue to W-3c Preview» (Continuar a una del formulario W-3c) y 
ver la página titulada «W-3c Preview for this Submission» (Presentación Preliminar del 
formulario W-3c). 
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PASO 13: En la página titulada «W-3c Preview for this Submission»: 
 

Puede ingresar los totales de los salarios e impuestos estatales y municipales. El Seguro Social 
no utilizará esta información ni tampoco la compartirá con ningún estado o entidad local.      
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Seleccione el botón de «Continue» para ir a la página titulada «Print Unsubmitted Form(s) W-
2c/W-3c for Review» (Imprima los Formularios W-2c/W-3c que no se han Presentado para 
Revisarlos). 

Seleccione el botón de Return to W-2c List para regresar a la página titulada «W-2c List for 
this Submission» (Lista de los formularios W-2c para esta Presentación). 

Seleccione el botón de «Save and Quit» para salir del W-2c por Internet sin presentar el 
informe de los registros salarios al Seguro Social. Cuando seleccione este botón, aparecerá la 
página titulada, «Are you sure you want to save and exit W-2c Online without submitting your 
annual wage report to SSA?» (¿Está seguro que quiere guardar los formularios W-2c y salir 
sin presentar los informes anuales de salarios al Seguro Social? para ayudarlo. 

 
PASO 14: En la página titulada, «Print Unsubmitted Form(s) W-2c/W-3c for Review»: 

Seleccione el botón de «Continue» para continuar a la página titulada, «Sign and Submit» 
(Firmar y Presentar).   

Seleccione el botón de «Return to W-2c List» (Regresar a la Lista de los formularios W-
2c) para regresar a la página titulada «W-2c List for this Submission» (Lista de los 
formularios W-2c para esta Presentación). 

Seleccione el botón que dice «Save and Quit» para salir del W-2c sin presentar la 
información al Seguro Social. Cuando seleccione este botón, aparecerá la página titulada 
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«Are you sure you want to save and exit W-2c Online without submitting your annual wage 
report to SSA» (¿Está seguro que quiere guardar los formularios W-2c y salir sin presentar 
los informes anuales de salarios al Seguro Social?) para ayudarlo. 

 

PASO 15: En la página titulada «Sign and Submit»: 

Seleccione el encasillado para verificar la exactitud del informe y seleccione el botón que dice 
«Submit This Wage Report Correction» (Presentar este Informe de Corrección de Salario) 
para presentar la corrección del registro de su salario. El sistema mostrará una página con una 
ventanilla despegable en la parte superior diciendo «Confirmation Receipt - Your File Was 
Received» (Recibo de Confirmación - Su registro ha sido recibido). 

Seleccione el botón de «Save and Quit» para guardar los W-2c y salir sin presentar la 
corrección de su registro de salario al Seguro Social. Cuando seleccione este botón, aparecerá 
la página titulada «Are you sure you want to save and exit W-2c Online without submitting 
your annual wage report to SSA» (¿Está seguro que quiere guardar los formularios W-2c y 
salir sin presentar su informe anual de salarios al Seguro Social?) para ayudarlo. 

Seleccione el botón de «Previous» (Anterior) para regresar a la página titulada «Print 
Unsubmitted Form(s) W-2c for Review» (Imprimir los Formularios W-2c que No han sido 
Presentados para Revisión). 
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PASO 16: En la ventanilla despegable: 

 
Seleccione el botón de «OK» para imprimir la página titulada «Confirmation Receipt - Your 
File Was Received» (Recibo de Confirmación - Su registro ha sido recibido).  

Seleccione el botón de «Cancel» para cerrar la ventanilla desplegable. 
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PASO 17: En la página titulada «Confirmation Receipt – Your File Was Received»: 

Seleccione el botón de «Print this Page» para imprimir la página de confirmación.  

Seleccione el botón de «Go to Save Oficial PDF» (Guardar el Documento Oficial en formato 
de .pdf) para ir a la página «Save PDF» (Guardar el .pdf). 

El registro de su salario estará disponible para que lo revise bajo su cuenta de BSO hasta la 
fecha que se muestra en la página de su «Save PDF». 

 

PASO 18: En la página titulada «Save PDF»: 

Oprima el botón derecho del ratón en el nombre del registro (<filename.pdf>) para ver o 
guardar el informe presentado.  

 Seleccione el botón de «Start a New Wage Report Correction» para regresar a la página 
titulada, «Before You Create Your Form(s) W-2c/W-3c» (Antes que Comience a Crear su 
Formulario(s) W-2c/W-3c). 

 Seleccione el botón de «View Unsubmitted Reports» (Ver los Informes que No se han 
Presentado) para ir a la página titulada «Unsubmitted Reports».  Seleccione el botón de EWR 
home para regresar a la página inicial del «EWR».   
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LECCIÓN 2: DESCARGUE LOS REGISTROS PRESENTADOS 

Siga las siguientes instrucciones para descargar un expediente en formato de Adobe que contiene los 
formularios W-2c y W-3c para un informe del formulario W-2c por Internet presentado durante los 
últimos 30 días.      

Informes de registros de salarios que ya han sido presentados están disponibles por 30 días o hasta el 31 
de diciembre, lo que ocurra primero.  

PASO 1: Seleccione el enlace que dice «Save (or Print) Submitted W-2c Report(s)/PDF to Your 
Computer» (Guarde en su computadora [o Imprima] los informes de los formularios  
W-2c/PDF presentados) que está bajo la ficha titulada «EWR home» de los formularios  
W-2c/W-3c Online. El sistema mostrará la página titulada «Download Submitted Reports» 
(Descargar los Informes Presentados).  

  
PASO 2:  Oprima el botón derecho del ratón en el enlace WFID en la página titulada «Download 

Submitted Reports» (Descargar los Informes Presentados) para ver un menú que incluye las 
siguientes opciones:   

• Seleccione el botón de «Save Target As» (Guardar el Registro Como) para descargar el 
expediente a su computadora.  

• Seleccione el botón de «Open in New Window» (Abrir en una Ventana Nueva) para ver 
el registro. 

Se requiere el programa de computadora «Adobe Acrobat Reader» para ver el expediente de 
salarios que descargó. Si no tiene una copia de este programa de computadora, puede obtener 
una copia en www.adobe.com.  

Nota aclaratoria: Si el informe presentado fue borrado por el usuario usando el procedimiento 
del «Submission Status» (Estado de la Presentación), aparecerá un mensaje en pantalla 
haciéndole saber al usuario que el informe que se busca no puede ser descargado. 

http://www.adobe.com/


Guía del BSO – Año Tributable 2012                                                                                                  W-2c por Internet 

   
Administración del Seguro Social  Página 18 

Seleccione el botón de «Quit» (Salir) para regresar a «EWR home» la página inicial. 

Seleccione el botón de « Start a New Report» (Comenzar un Nuevo Informe) para proceder a la 
página de «Before You Create Your Form(s) W-2c/W-3c» (Antes que Comience a Crear su 
Formulario(s) W-2c/W-3c). 
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Apéndice: Otras páginas 

1. ¿Está Seguro que Quiere Borrar esta Página del W-2c? 
Si el usuario selecciona el botón de «Delete This W-2c» (Borrar este formulario W-2c) en la página 
titulada «Enter W-2c Information» (Ingrese la información del formulario W-2c) o el enlace de «Delete» 
(Borrar) en la página titulada, «W-2c List for this Submission» (Lista de los formularios W-2c para esta 
presentación) el sistema mostrará la página con la pregunta «Are you sure you want to delete this W-2c?» 
(¿Está seguro que quiere borrar este W-2c?).    

 

2. Página de Restricciones del W-2c por Internet 
Los usuarios pueden tener acceso a la página de «W-2c Online Restrictions» seleccionando el botón de 
«Continue» en la página titulada «Before You Create Your Form(s) W-2c/W-3c» cuando es seleccionado 
el encasillado que dice «Yes, one or more of these situations apply to this wage report» (Sí, una o más de 
estas situaciones aplican a este registro de salario). 
 

 

3.   ¿Está Seguro que Quiere Guardar y Salir de la Página W-2c por Internet Sin Presentar 
su Informe de Registro Anual de Salarios al Seguro Social? 
Si el usuario selecciona el botón de «Save and Quit» en la página titulada «W-2c List for this 
Submission (ABC Limited)» o en la página «W-3c Preview for this Submission» o en la página «Print 
Unsubmitted Form(s) W-2c/W-3c for Review» o en la página «Sign and Submit», el sistema mostrará la 
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página con la pregunta «Are you sure you want to save and exit W-2c Online without submitting your 
annual wage report to SSA?» (¿Está seguro que quiere guardar y salir de la página W-2c por Internet sin 
presentar su informe de registro anual de salarios al Seguro Social?). 

 

4.    ¿Está Seguro que Quiere Borrar el Informe Que No ha sido Presentado?  
Si un usuario selecciona el botón de «Delete» en la página titulada «Unsubmitted Reports», el sistema 
mostrará la página con la pregunta «Are you sure you want to delete the unsubmitted report?» (¿Está 
seguro que quiere borrar el informe que no ha sido presentado?).  
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